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1: Why do I get an "Unprotected Formula" message? - Excel
Lock and protect formulas with Format Cells and Protect Sheet functions By default, all cells on a worksheet are locked,
so you must unlock all of the cells first. 1.

The most common way of preventing people from tampering with your Excel formulas is to protect the
worksheet. However, this does not just lock formulas, but rather locks all cells on the sheet and stops users
from editing any of the existing cells and entering any new data. Sometimes you may not want to go that far.
The following steps demonstrate how you can only lock a selected formula s or all cells with formulas on a
given sheet, and leave other cells unlocked. Unlock all cells in the worksheet. For starters, unlock all of the
cells on your worksheet. I realize that it may sound confusing because you have not locked any cells yet.
However, by default, the Locked option is turned on for all cells on any Excel worksheet, whether an existing
or a new one. This does not mean that you cannot edit those cells, because locking cells has no effect until you
protect the worksheet. So, if you want to lock only cells with formulas, be sure to perform this step and unlock
all cells on the worksheet first. If you want to lock all cells on the sheet whether those cells contain formulas,
values or are blank , then skip the first three steps, and go right to Step 4. Or, right-click any of the selected
cells and choose Format Cells from the context menu. This will unlock all cells in your worksheet. Select the
formulas you want to lock. Select the cells with the formulas you want to lock. To select all cells with
formulas on the sheet, do the following: In the Go To Special dialog box, check the Formulas radio button this
will select the check boxes with all formula types , and click OK: Lock cells with formulas. Now, go to lock
the selected cells with formulas. The Locked option prevents the user from overwriting, deleting or changing
the contents of the cells. To lock formulas in Excel, checking the Locked option is not sufficient because the
Locked attribute has no effect unless the worksheet is protected. To protect the sheet, do the following. The
Protect Sheet dialog window will appear, and you type a password in the corresponding field. This password
is needed for unprotecting the worksheet. No one, even yourself, will be able to edit the sheet without entering
the password, so be sure to remember it! Also, you need to select the actions that are allowed in your
worksheet. As you see in the screenshot above, two checkboxes are selected by default: Select locked cells and
Select unlocked cells. If you click the OK button leaving only these two options selected, the users, including
yourself, will be able only to select cells both locked and unlocked in your worksheet. If you want to allow
some other actions, e. The Confirm Password dialog box will appear and ask you to retype the password, to
prevent an accidental misprint from locking up your Excel worksheet forever. Retype the password and click
OK. Your Excel formulas are now locked and protected, though visible in the formula bar. If you also want to
hide formulas in your Excel sheet, read through the following section. To hide Excel formulas, perform the
following steps. Select a cell or range of cells containing the formulas you want to hide. Open the Format
Cells dialog by doing any of the following: Right-click the selected cell s and choose Format Cells from the
context menu. In the Format Cells dialog box, switch to the Protection tab, and select the Hidden checkbox. It
is this option that prevents an Excel formula from being shown in the formula bar. Click the OK button.
Protect your Excel worksheet by performing these steps. Please remember that locking cells and hiding
formulas has no effect until you protect the worksheet a short notice right underneath the Locked and Hidden
options on the Format Cells dialog points to the next steps. To make sure of this, select any cell with a
formula, and look at the formula bar, the formula will still be there. To really hide formulas in Excel, be sure
to protect the worksheet. How to remove protection and unhide formulas in Excel To get the previously
hidden formulas to show in the formula bar again, do one of the following: On the Home tab, in the Cells
group, click the Format button, and select Unprotect Sheet from the drop-down menu. Then type the password
you entered when protecting the spreadsheet, and click OK. This is how you can hide and lock formulas in
Excel. In the next tutorial, we will discuss various ways to copy formulas and you will learn how to apply a
formula to all cells in a given column in a click. I thank you for reading and hope to see you again soon! You
may also be interested in:
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2: excel - How do I lock cells containing formulas but still allow macros to work? - Stack Overflow
Excel: Protect Cells That Contain Formulas This page is an advertiser-supported excerpt of the book, Power Excel from
MrExcel - Excel Mysteries Solved. If you like this topic, please consider buying the entire e-book.

Learn Excel from MrExcel Excel: If you like this topic, please consider buying the entire e-book. I have to key
in data in a large number of cells in a month-end financial statement. How can I protect just the formula cells?
Allow people to enter details but protect the formulas. After unlocking all cells, you can use the Go To Special
dialog to select only the cells with formulas and lock just those cells. By default, all cells in a worksheet start
with their Locked property set to TRUE, but you may not realize this until you turn on protection for the first
time. The first step is to unlock all the cells: Click on the Protection tab in the Format Cells dialog. You will
see that the Locked option is chosen. All cells start out locked by default. Uncheck the Locked box. Click OK
to close the Format Cells dialog. On the Go To Special dialog box, choose the Formulas option button. Select
only formula cells. Excel will reduce the selection to only cells with formulas. Select Home, Format
dropdown, Lock Cells. This will lock only the selected cells, which are the formula cells. Enable protection
for the sheet. Note that if you skip this final step, you can still accidentally overwrite your formulas. Select
Home, Format dropdown, Protect Sheet. Excel will display the Protect Sheet dialog. The default settings are
sufficient protection. The default settings are fine. Now if you accidentally try to enter something in a formula
cell, Excel will prevent you from entering the data. For more resources for Microsoft Excel.
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3: How to lock cells in Excel and unlock certain cells on a protected sheet
In my experience, many Excel users get frustrated and confused when they try to protect the worksheet cells that
contain formulas. In this tutorial, I walk you through the three steps in the process.

Initially, I was totally clueless on how this task can be done. But later after doing some Google searches I got
a few ideas on how I can effortlessly identify the formula cells in excel. And today to share my experiences
with you guys, In this post I will throw some light on a few methods that can help you to find out formula cells
in your spreadsheets. So here we go: Later you can change the formatting or background colour of the selected
cells to make them stand out from the rest. Below are the step by step instructions for accomplishing this:
After checking this radio button you will notice that few checkboxes like: Numbers, Errors, Logicals and Text
are enabled, these checkboxes signify the return type of the formulas. Here in our example we will keep all of
these return types checked. Next, without clicking anywhere on your spreadsheet change the background
colour of all the selected cells. Now your formula cells can be easily identified. Using a built-in Excel
formula: If you have worked with excel formulas then probably you may be knowing that excel has a formula
that can find whether a cell contains a formula or not. The formula that I am talking about is: Using a Macro
for identifying the cells that contain formulas: I have created a VBA Macro that can find and colour any cells
that contain formula in the total used range of the Active sheet. To use this macro simply follow the below
procedure: This Macro will change the background colour of all the formula containing cells and thus makes it
easier to identify them easily. He is tech Geek who loves to sit in front of his square headed girlfriend his PC
all day long. Ankit has a strong passion for learning Microsoft Excel.
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4: How to lock and hide formulas in Excel
If you want to lock all cells on the sheet (whether those cells contain formulas, values or are blank), then skip the first
three steps, and go right to Step 4. Select the entire worksheet either by pressing Ctrl + A, or clicking the Select All
button (the gray triangle in the top left corner of the worksheet, to the left of the letter A).

Because the Locked attributed is selected for all cells by default, protecting the sheet automatically locks cells.
The detailed steps to lock cells in Excel , Excel and Excel follow below. Unlock all cells on the sheet. By
default, the Locked option is enabled for all cells on the sheet. That is why, in order to lock certain cells in
Excel, you need to unlock all cells first. Select cells, ranges, columns or rows you want to protect. To lock
cells or ranges, select them in a usual way by using the mouse or arrow keys in combination with Shift. To
select non-adjacent cells, select the first cell or a range of cells, press and hold the Ctrl key, and select other
cells or ranges. To protect columns in Excel, do one of the following: To select adjacent columns, right click
on the first column heading and drag the selection across the column letters rightwards or leftwards. Or, select
the first column, hold down the Shift key, and select the last column. To protect rows in Excel, select them in
a similar manner. For the detailed guidance with screenshots, please see How to lock and hide formulas in
Excel. Locking cells in Excel has no effect until you protect the worksheet. This can be confusing, but
Microsoft designed it this way, and we have to play by their rules: On the Review tab, in the Changes group,
click the Protect Sheet button. Or, right click the sheet tab and select Protect Sheetâ€¦ in the context menu.
You will be prompted to enter the password optional and select the actions you want to allow users to perform.
Do this, and click OK. You can find the detailed instructions with screenshots in this tutorial: How to protect a
sheet in Excel. The selected cells are locked and protected from any changes, while all other cells in the
worksheet are editable. How to unlock cells in Excel unprotect a sheet To unlock all cells on a sheet, it is
sufficient to remove the worksheet protection. To do this, right-click the sheet tab, and select Unprotect
Sheetâ€¦ from the context menu. Alternatively, click the Unprotect Sheet button on the Review tab, in the
Changes group: For more information, please see How to unprotect an Excel sheet. As soon as the worksheet
is unprotected, you can edit any cells, and then protect the sheet again. If you want to allow users to edit
specific cells or ranges on a password-protected sheet, check out the following section. How to unlock certain
cells on a protected Excel sheet In the first section of this tutorial, we discussed how to lock cells in Excel so
that no one even yourself can edit those cells without unprotecting the sheet. However, sometimes you may
want to be able to edit specific cells on your own sheet, or let other trusted users to edit those cells. In other
words, you can allow certain cells on a protected sheet to be unlocked with password. Select the cells or
ranges you want to unlock by a password when the sheet is protected. This feature is available only in an
unprotected sheet. In the New Range dialog window, do the following: In the Title box, enter a meaningful
range name instead of the default Range1 optional. In the Refers to cells box, enter a cell or range reference.
By default, the currently selected cell s or range s are included. In the Range password box, type a password.
Or, you can leave this box empty to allow everyone to edit the range without password. Click the OK button.
In addition to, or instead of, unlocking the specified range by a password, you can give certain users the
permissions to edit the range without password. To do this, click the Permissionsâ€¦ button in the lower left
corner of the New Range dialog and follow these guidelines steps 3 - 5. The Confirm password window will
appear and prompt you to re-type the password. The new range will get listed in the Allow Users to Edit
Ranges dialog. If you want to add a few more ranges, repeat steps 2 - 5. Click the Protect Sheet button at the
button of the window to enforce the sheet protection. In the Protect Sheet window, type the password to
unprotect the sheet, select the check boxes next to the actions you want to allow, and click OK. It is
recommended to protect a sheet with a different password than you used to unlock the range s. In the password
confirmation window, re-type the password and click OK. Now, your worksheet is password protected, but
specific cells can be unlocked by the password you supplied for that range. And any user who knows that
range password can edit or delete the cells contents. Allow certain users to edit selected cells without
password Unlocking cells with password is great, but if you need to frequently edit those cells, typing a
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password every time can be a waste of your time and patience. In this case, you can set up permissions for
specific users to edit some ranges or individual cells without password. This features works on Windows XP
or higher, and your computer must be on a domain. Assuming that you have already added one or more ranges
unlockable by a password , proceed with the following steps. In the Allow Users to Edit Ranges window,
select the range for which you want to change the permissions, and click the Permissionsâ€¦ button. The
Permissionsâ€¦ button is also available when you are creating a new range unlocked by a password. The
Permissions window will open, and you click the Addâ€¦ button. In the Enter the object names to select box,
enter the names of the user s whom you want to allow to edit the range. To see the required name format, click
the examples link. Or, simply type the user name as it is stored on your domain, and click the Check Names
button to verify the name. Excel has verified my name and applied the required format: Under Group or user
names, specify the permission type for each user either Allow or Deny , and click the OK button to save the
changes and close the dialog. If a given cell belongs to more than one range unlocked by a password, all users
who are authorized to edit any of those ranges can edit the cell. In this case, you can lock all cells on your
Excel sheet except for input cells where your users are supposed to enter their data. One of possible solutions
is to use the Allow Users to Edit Ranges feature to unlock selected cells, as demonstrated above. Another
solution could be modifying the built-in Input style so that it not only formats the input cells but also unlocks
them. For this example, we are going to use an advanced compound interest calculator that we created for one
of the previous tutorials. This is how it looks like: Users are expected to enter their data in cells B2: To do this,
perform the following steps. On the Home tab, in the Styles group, find the Input style, right click it, and then
click Modifyâ€¦. To add it, just select the Protection checkbox: If you want only to unlock input cells without
changing cell formatting, uncheck all boxes on the Style dialog window other than the Protection box. To
change this, click the Formatâ€¦ button in the upper right corner of the Style window. The Style dialog
window will update to indicate the No Protection status like shown below, and you click OK: And now, select
the input cells on your sheet and click the Input style button on the ribbon. The selected cells will get both
formatted and unlocked at the same time: As you may remember, locking cells in Excel has no effect until the
sheet protection is turned on. To quickly find locked and unlocked cells, you can use the CELL function,
which returns information about the formatting, location and other properties if a specified cell. To determine
the protection status of a cell, enter the word "protect" in the first argument of your CELL formula, and a cell
address in the second argument. It cannot be easier, right? However, if you have more than one column of
data, the above approach is not the best way to go. To highlight locked cells: D2 that contain SUM formulas.
The following screenshot demonstrates a rule that highlights those locked cells: The conditional formatting
feature is disabled on a protected sheet. Excel conditional formatting based on another cell value. This is how
you can lock one or more cells in your Excel sheets. If someone knows any other way to protect cells in Excel,
your comments will be truly appreciated. I thank you for reading and hope to see you on our blog next week.
You may also be interested in:
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5: How To Lock Excel Cells With Formulas To Prevent Editing
Now again if there are formulas in several cells and are scattered all over, it may be time consuming to look for cells
containing formulas. Video at the end This article shows you a fast and easy way of protecting all your formulas in the
worksheet at one go.

Individual cells can be locked and then the worksheet protected so that important cell contents are safe. Entire
workbooks can be protected as well. This tutorial discusses the steps necessary to lock cells and protect
worksheets and workbooks in Microsoft Excel. Two steps are involved and both must be completed before
protection is activated. Overview There are two elements involved in the protection of worksheet data. First,
any cell that needs protection must be locked. Second, the worksheet containing the locked cell must be
protected. First we will discuss how to lock and unlock individual cells or groups of cells. Then we will
discuss how to protect the worksheet in all versions of Excel. In addition, we will discuss the different options
on the "Protect Sheet" window and which you may wish to choose. The Format Options window has a total of
six tabs and they are discussed in our tutorial Formatting Cells in Excel. The easiest way to get to the Format
Options window from all versions of Excel is from the right-click menu. Click inside of a cell or highlight
multiple cells, right-click, and click Format cells We always recommend the "right click" method of quickly
reaching the Format Options window. We will note that in Excel and newer versions, some of the formatting
options can be found on the ribbon. For example, "alignment" and "number" options are on the Home tab.
This is a great feature for preventing complex formulas and functions from being accidentally erased. See
"Protecting a Worksheet" below. All cells are locked by default. To unlock all worksheet cells in one step,
click in the top-left cell of the worksheet, as shown in the image, to select all of the worksheet cells. Then
right-click, select "Format cells The Protection tab is shown below. The next step is to lock just those cells that
contain precious contents. Click in a cell, right-click to get to the Format Options window, and check
"Locked" on the Protection tab. Contiguous cells can be formatted in one step by highlighting the entire range
and then locking. Non-contiguous cells can be locked in one step by pressing and holding the CTRL key while
selecting the individual cells. The most important cells to keep locked are those that contain formulas and
functions. The point is to allow the user to work with the spreadsheet WHILE it is in protected mode so
important data and complex formulas are kept safe from accidental erasure or deletion. Worksheets can be
unprotected, when absolutely necessary, by following the same steps below but selecting "unprotect. Excel , ,
and higher versions To protect a worksheet in newer versions of Excel beginning with Excel , click the
Review tab, click Protect Worksheet or Protect Sheet , and click OK. See image at right. You may enter a
password before clicking OK, but be very careful. See "About Passwords" below. If the worksheet is already
protected, the icon in the Review tab is "Unprotect Worksheet" or "Sheet". When a worksheet is already
protected, the menu item reads "Unprotect Sheet. By default, Excel has the first two options checked: If both
of these default settings are taken, no cell in the worksheet can be formatted as long as the sheet is protected,
The "Format cells" option on the right-click menu is grayed out. Nor can columns or rows be added, deleted,
or formatted. Other restrictions also apply. If you are the only user of the worksheet, you may prefer to
un-check "Select locked cells," KEEP "Select unlocked cells" checked, and check some of the other options so
that you have more power to make changes to the worksheet without disturbing the locked cells, or having to
unprotect the sheet. By checking some of the other options on the Protect Sheet window, you will be able to
format the unlocked cells, insert and delete rows and columns, and so on. There will be some restrictions if
your desired activity is in the area of locked cells. What happens when you click in a locked cell? As soon as
you try to enter data, delete the data, format the cell, and so on, Excel displays a message that reads, "The cell
or chart that you are trying to change is protected and therefore read-only" and explains how to unprotect the
sheet. Protecting a Workbook A workbook can also be protected. Follow the instructions for protecting a
worksheet, but look for "workbook" instead. Protecting a workbook only prevents users from changing the
structure of the workbook. Worksheets cannot be inserted, renamed, added, deleted, moved, or copied. We
hope our tutorial on protecting your important worksheet data has been helpful.
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6: How to Lock Cells in Excel
How To Protect Cells That Contain Formulas In Excel Hindi - Dont allow formula editing by protecting cells containing
formulas, but allow other cells to be edited.

Microsoft Excel â€” Workbook and Worksheet Lock and Protect Cells Containing Formulas You may want to
let users change cells containg data without providing them access to change formulas. You can keep cells
containing formulas under lock and key without having to protect your entire sheet or workbook. When we
create a spreadsheet, most of us need to use formulas of some sort. The easiest and most common way of
barring people from playing with your formulas is to protect your worksheet. Sometimes you do not want to
go this far. By default, all cells on a worksheet are locked; however, this has no effect unless worksheet
protection has been applied. Here is a very easy way to apply worksheet protection so that only formula cells
are locked and protected. Ctrl-G or F5 , and click Special. The preceding method certainly saves a lot of time
and eliminates possible errors locating formulas so that you can protect them. Unfortunately, it can also
prevent users from using certain features, such as sorting, formatting changes, aligning text, and many others
you might not be concerned with, even when in an unlocked cell. You can overcome this problem in two
ways. Data validation is far from bulletproof when it comes to preventing users from entering nonvalidated
data into cells. Users can still paste into a validated cell any data they want and, in doing so, remove the
validation from that cell unless the copied cell also contains data validation, in which case this validation
would override the original validation. Now select Formulas from the Go To Special dialog and, if needed,
limit the formulas to the subtypes underneath. Validation formulas This method will prevent a user from
accidentally overtyping into any formula cells - although, as stressed in the earlier warning, it is not a fully
secure method and should be used only for accidental overtyping, etc. To start, ensure that only the cells you
want protected are locked and that all other cells are unlocked. Right-click the Sheet Name tab, select View
Code from the pop-up menu, and enter the following code: If a password is used, change the word Secret to
your password. Now, each time you select a cell that is locked, your worksheet will automatically protect
itself. The moment you select any cell that is not locked, your worksheet will unprotect itself. The keyword
used in the code, Target, will refer only to the cell that is active at the time of selection. For this reason, it is
important to note that if a user selects a range of cells with the active cell being an unlocked cell , it is possible
for him to delete the entire selection because the target cell is unlocked and, therefore, the worksheet
automatically will unprotect itself.
7: How to lock all the cells with formulas in a workbook
Lock and Protect Cells Containing Formulas You may want to let users change cells containg data without providing
them access to change formulas. You can keep cells containing formulas under lock and key without having to protect
your entire sheet or workbook.

8: Create Login Form Access Database Part 4 â€“ AGCReMp3
The cell B4 contains the formula that will sum the cells B2 and B3. You want users to be able to input any value in the
cells B2 and B3 but you don't want them to accidentally (or intentionally) edit the sum formula.

9: Excel: Protect Cells That Contain Formulas - Excel Articles
Protecting Cells Containing Formulas in an Unprotected Sheet In this article, to protect cells containing formula in an
unprotected sheet, we will use Data validation option. Data validation is an awesome feature of Excel that you can use
to describe limitations or restrictions on what type of data can be used in a cell.
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